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 مادختساب دعب نع لوصولاب ةصاخلا VPN ةكبشل يساسألا نيوكتلا دنتسملا اذه فصي
IKEv2 ةقداصمو ISE ىلع FTD ةطساوب اهترادإ متت يتلا FMC.

ةيساسألا تابلطتملا

تابلطتملا

:ةيلاتلا عيضاوملاب ةفرعم كيدل نوكت نأب Cisco يصوت

 تنرتنإلا حاتفم لدابت نم 2 رادصإلاو ،TLS و ،ةيساسألا ةيرهاظلا ةصاخلا تاكبشلا
(IKEv2)

•

• RADIUS و (AAA) ةيساسألا ةبساحملاو ضيوفتلاو ةقداصملا
•FirePOWER (FMC) ةرادإ زكرم ةبرجت

ةمدختسملا تانوكملا



:ةيلاتلا جماربلا تارادصإ ىلإ دنتسملا اذه يف ةدراولا تامولعملا دنتست

•Cisco نم FirePOWER (FTD) 7.2.0 ديدهت دض عافدلا
Cisco FMC 7.2.0•
AnyConnect 4.10.07073•
Cisco ISE 3.1•

 .ةصاخ ةيلمعم ةئيب يف ةدوجوملا ةزهجألا نم دنتسملا اذه يف ةدراولا تامولعملا ءاشنإ مت
 تناك اذإ .(يضارتفا) حوسمم نيوكتب دنتسملا اذه يف ةمدختسُملا ةزهجألا عيمج تأدب
.رمأ يأل لمتحملا ريثأتلل كمهف نم دكأتف ،ليغشتلا ديق كتكبش

ةيساسأ تامولعم

 ءاشنإل نيمدختسملا نيلوكوتوربلا (SSL) ةنمآلا ليصوتلا ذخآم ةقبطو IKEv2 دعي
 ةقداصمو ريفشت بيلاسأ IKEv2 رفوي .VPN تاكبش قايس يف ةصاخو ،ةنمآ تالاصتإ
.VPN تالاصتال نامألا نم اعفترم ىوتسم رفوي امم ،ةيوق

 حمسي يذلاو ،ثدحألا تارادصإلاو FTD نم 7.2.0 رادصإلا نيوكتل الاثم دنتسملا اذه مدقي
 نكمي ،ليمعك .IKEv2 و (TLS) لقنلا ةقبط نامأ مادختسال VPN ةكبش ىلإ دعب نع لوصولاب
.ةددعتم ةيساسأ ةمظنأ ىلع موعدم وهو ،Cisco AnyConnect مادختسإ

نيوكتلا

SSL ةداهش داريتسإ .1

.AnyConnect نيوكت دنع ةيرورض تاداهشلا نوكت

 :ةداهشلل يوديلا ليجستلا ىلع دويق كانه
 ةداهشلا عيقوت بلط ءاشنإ لبق (CA) قدصملا عجرملا ةداهش ىلع لوصحلا مزلي ،FTD يف .1
(CSR). 
 متي ،ايجراخ (CSR) هسفن ليمعلا ةطساوب لادبتسالل ةلباقلا ءازجألا ءاشنإ مت اذإ .2
.PKCS12 نم ةفلتخم ةقيرط مادختسإ

 ةلهسلاو ةنمآلا ةقيرطلا نكلو ،FTD زاهج ىلع ةداهش ىلع لوصحلل قرطلا نم ديدعلا كانه
:كلذب مايقلا ةقيرط كيلإو .CA لبق نم هعيقوتو CSR ءاشنإ يه

 .Add Cert Enrollment قوف رقناو ،Objects > Object Management > PKI > Cert Enrollment ىلإ لقتنا .1

. RAVPN-SSL-cert TrustPointمسا لخدأ .2

 يف حضوم وه امك قدصملا عجرملا ةداهش قصلو Manual ةئيه ىلع ليجستلا عون رتخأ ،بيوبتلا ةمالع CA Information تحت .3

.ةروصلا



FMC - ةداهش CA

:لاثملا ليبس ىلع .عوضوملا مسا لخدأ ،Certificate Parameters تحت .4



FMC - ةداهشلا تاملعم

 2048 ل ىندألا دحلا نوكي ،RSA ل ةبسنلاب .تبلا مجحو مسا ريفوتب مقو ،حاتفملا عون رتخأ ،بيوبتلا ةمالع Key تحت .5

.تب ةدحو

.Save رقنا .6



FMC - ةداهشلا حاتفم

 .Devices > Certificates > Add > New Certificate ىلإ لقتنا .7

.ةروصلا يف حضوم وه امكAdd رقناو ،هؤاشنإ مت يذلا TrustPoint رتخأ ،Cert Enrollment تحت .Device رتخأ .8



FMC - يف ةداهشلا ليجست FTD

.Yes رتخأ ،CSR ءاشنإب ةبلاطم ضرع متيو ،ID رقنا .9

FMC - ةداهش CA ةلجسم



FMC - ءاشنإ CSR

.ةيوهلا ةداهش ىلع لوصحلل CA عم هتكراشم نكمي يذلا CSR ءاشنإ متي .10

 حضوم وه امك Browse Identity Certificate Import رقنلاب صرقلا نم اهرتخإ ،base64 قيسنتب CA نم ةيوهلا ةداهش يقلت دعب .11

.ةروصلا يف



FMC - ةيوهلا ةداهش داريتسإ

:اهنأ ىلع ةقثلا RAVPN-SSL-certةطقن ىلإ رظني ،داريتسالا حاجن درجمب .12

FMC - ليجست حاجن TrustPoint

RADIUS مداخ نيوكت .2

FMC ىلع FTD ةرادإ .2.1

. Objects > Object Management > RADIUS Server Group > Add RADIUS Server Group ىلإ لقتنا .1

.+ قوف رقنلاب RADIUS مداوخ فضأو ISE مسالا لخدأ .2



FMC - مداخ نيوكت RADIUS

.ISE مداخ ىلع دوجوملا هسفن وهو (حاتفملا) كرتشملا رسلا عم ISE Radius مداخب صاخلا IP ناونع ركذأ .3

.ISE مداخب (FTD) ةعرسلا قئاف لاسرإلا جمانرب هلالخ نم لصتي يذلاSpecific Interface وأ Routing امإ رتخأ .4



.ةروصلا يف حضوم وه امك  Save رقنا .5

FMC - مداخ ISE



.ةروصلا يف حضوم وه امك  RADIUS Server Group نمض مداخلا ةفاضإ متت ،اهظفح درجمب .6 

FMC - مداوخ ةعومجم RADIUS

ISE ىلع FTD ةرادإ .2.2

.Add ىلإ رقناو ،  Network Devices ىلإ لقتنا .1

.FTD لاصتا ةهجاو وه يذلاRADIUS IP Address ليمعو مداخلل "Cisco-RADIUS" مسا لخدأ .2

.Shared Secret فضأ ،Radius Authentication Settings تحت .3

. Save رقنا .4

ISE - ةكبشلا ةزهجأ

.Add قوف رقناو ،Network Access > Identities > Network Access Users ىلإ لقتنا ،نيمدختسم ءاشنإل .5

 .ةجاحلا بسح UserNameAndLogin رورم ةملك ءاشنإب مق .6



ISE - نومدختسملا

 رتخاو ،Policy > Policy Sets > Default > Authentication Policy > Default ىلإ لقتنا ،ةيساسألا ةسايسلا دادعإ لجأ نم .7

All_User_ID_Stores.

 يف حضوم وه امكPermitAccess رتخاو ,Policy > Policy Sets > Default > Authorization Policy > Basic_Authenticated_Access ىلإ لقتنا .8

.ةروصلا

ISE - ةقداصملا ةسايس

ISE - ليوختلا ةسايس

FMC ىلع VPN يمدختسمل نيوانع عمجت ءاشنإ .3

 .Objects > Object Management > Address Pools > Add IPv4 Pools ىلإ لقتنا .1

 .يرايتخإ عانقلاو ،ناونعلا قاطنو RAVPN-Pool مسالا لخدأ .2

.ظفح قوف رقنا .3



FMC - نيوانعلا عمجت

AnyConnect روص ليمحت .4

 .Objects > Object Management > VPN > AnyConnect File > Add AnyConnect File ىلإ لقتنا .1

 وه امك Save رقنا ،صرقلا نم AnyConnect فلم رايتخال Browse قوف رقناو anyconnect-win-4.10.07073-webdeploy مسالا لخدأ .2

.ةروصلا يف حضوم



FMC - ليمع ةروص AnyConnect

XML فيرعت فلم ءاشنإ .5

فيرعتلا فلم ررحم يف 5.1

 .هحتفو software.cisco.com نم فيرعتلا فلم ررحم ليزنتب مق .1

..Server List > Add ىلإ لقتنا .2

.(راعتسملا مسالا مسا) نيمدختسملا ةعومجم عمRAVPN-IKEV2 FQDN ضرعلا مسا لخدأ .3

.ةروصلا يف حضوم وه امك  IPsec , Ok  يساسألا لوكوتوربلا رتخأ .4



مداوخلا ةمئاق - فيرعتلا فلم ررحم

. ClientProfile.xml مساب ظفح .مداوخلا ةمئاق ةفاضإ متت .5

ClientProfile.xml - فيرعتلا فلم ررحم

FMC ىلع .5.2

 .Objects > Object Management > VPN > AnyConnect File > Add AnyConnect File ىلإ لقتنا .1

 .صرقلا نم فلم ClientProfile.xml رايتخال Browse قوف رقناو ClientProfile امسا لخدأ .2

. Save رقنا .3

 



FMC - فيرعت فلم AnyConnect VPN

دعب نع لوصولا نيوكت .6

.ةروصلا يف حضوم وه امك لاصتا فيرعت فلم ةفاضإل + رقناوDevices > VPN > Remote Access ىلإ لقتنا .1

FMC - دعب نع لوصولا لاصتا فيرعت فلم

 يف حضوم وه امكGroup Policy يف+ رقنلاب ةعومجم جهن ءاشنإب مقو لاصتالا فيرعت فلم RAVPN-IKEV2مسا لخدأ .2

 .ةروصلا



FMC - ةعومجملا ةسايس

.ةروصلا يف حضوم وه امك  VPN SSL and IPsec-IKEv2 تالوكوتورب رتخأ ،RAVPN-group-policy مسالا لخدأ .3



FMC - تالوكوتورب VPN

 يف حضوم وه امكSave رقناو ،ةلدسنملا ةمئاقلا نم XML ClientProfile صيصخت فلم رتخأ ، AnyConnect > Profile تحت .4

.ةروصلا



FMC - فيرعت فلم AnyConnect

.as shown in the image + قوف رقنلاب RAVPN-Pool نيوانعلا عمجت فضأ .5



FMC - ليمعلا ناونع نييعت

.AAA Only رتخاو ،AAA > Authentication Method ىلإ لقتنا .6

.Authentication Server ISE (RADIUS) رتخأ .7



FMC - ةقداصم AAA

. ClientProfile.xml يف نيمدختسم ةعومجمك همادختسإ متي يذلاو ،راعتسم RAVPN-IKEV2مسا لخدأو ، Aliases ىلإ لقتنا .8

.Save رقنا .9



FMC - ةراعتسم ءامسأ

.اهب RAVPN IKEv2 نيكمت بجي يتلا ةهجاولا رتخاو ،Access Interfaces ىلإ لقتنا .10

.IKEv2 و SSL نم لكل ةيوهلا ةداهش رتخأ .11

.Save رقنا .12



FMC - لوصولا تاهجاو

 . Advanced ىلإ لقتنا .13

.+ قوف رقنلاب AnyConnect Client روص فضأ .14

FMC - ةمزح AnyConnect Client

 .ةروصلا يف حضوم وه امك Crypto Mapsفضأ ،IPsecتحت .15

FMC - ريفشتلا طئارخ

 .+ رقنب IKE Policy فضأ ، IPsec تحت .16



FMC - ةسايس IKE

. IPsec/IKEv2 Parameters فضأ ، IPsec تحت .17

FMC - تاملعم IPsec/IKEv2

.ديدج فيصوت RAVPN-IKEV2تقلخ ،Connection Profile تحت .18

19. Saveةروصلا يف ةحضوملا خسنلا.

FMC - لاصتالا عجرم RAPN-IKEV2



.نيوكتلا رشنب مق .20

FMC - لوكوتورب رشن FTD

AnyConnect فيرعت فلم نيوكت .7

. C:\ProgramData\Cisco\Cisco Anyconnect Secure Mobility Client\Profile  نمض ظوفحم ،رتويبمكلا ىلع دوجوملا فيرعتلا فلم

 
<#root>

<?xml version="1.0" encoding="UTF-8"?> <AnyConnectProfile xmlns="http://schemas[dot]xmlsoap<dot>org/encoding/" xmlns:xsi="http://www[dot]w3<dot>org/2001/XMLSchema-instance" xsi:schemaLocation="http://schemas[dot]xmlsoap[dot]org/encoding/ AnyConnectProfile.xsd"> <ClientInitialization> <UseStartBeforeLogon UserControllable="true">false</UseStartBeforeLogon> <AutomaticCertSelection UserControllable="true">false </AutomaticCertSelection> <ShowPreConnectMessage>false</ShowPreConnectMessage> <CertificateStore>All</CertificateStore> <CertificateStoreOverride>false</CertificateStoreOverride> <ProxySettings>Native</ProxySettings> <AllowLocalProxyConnections>true</AllowLocalProxyConnections> <AuthenticationTimeout>12</AuthenticationTimeout> <AutoConnectOnStart UserControllable="true">false</AutoConnectOnStart> <MinimizeOnConnect UserControllable="true">true</MinimizeOnConnect> <LocalLanAccess UserControllable="true">false</LocalLanAccess> <ClearSmartcardPin UserControllable="true">true</ClearSmartcardPin> <AutoReconnect UserControllable="false">true <AutoReconnectBehavior UserControllable="false">DisconnectOnSuspend </AutoReconnectBehavior> </AutoReconnect> <AutoUpdate UserControllable="false">true</AutoUpdate> <RSASecurIDIntegration UserControllable="true">Automatic </RSASecurIDIntegration> <WindowsLogonEnforcement>SingleLocalLogon</WindowsLogonEnforcement> <WindowsVPNEstablishment>LocalUsersOnly</WindowsVPNEstablishment> <AutomaticVPNPolicy>false</AutomaticVPNPolicy> <PPPExclusion UserControllable="false">Disable <PPPExclusionServerIP UserControllable="false"></PPPExclusionServerIP> </PPPExclusion> <EnableScripting UserControllable="false">false</EnableScripting> <EnableAutomaticServerSelection UserControllable="false">false <AutoServerSelectionImprovement>20</AutoServerSelectionImprovement> <AutoServerSelectionSuspendTime>4</AutoServerSelectionSuspendTime> </EnableAutomaticServerSelection> <RetainVpnOnLogoff>false </RetainVpnOnLogoff> </ClientInitialization> <ServerList> <HostEntry> 

 <HostName>RAVPN-IKEV2</HostName> <HostAddress>ftd.cisco.com</HostAddress> <UserGroup>RAVPN-IKEV2</UserGroup> <PrimaryProtocol>IPsec</PrimaryProtocol>

 </HostEntry> </ServerList> </AnyConnectProfile>

 



 

 
 
 

 فيرعت فلم ليزنت درجمب ةعومجملا جهن بجومب يقفن لاصتا لوكوتوربك SSL ليمع ليطعتب ىصوي :ةظحالم
 لكشب نيمدختسملا لاصتا ةيناكمإ نمضي اذهو .نيمدختسملا عيمجل يصخشلا رتويبمكلا زاهج ىلإ ليمعلا
.IKEv2/IPsec ل يقفنلا لاصتالا لوكوتورب مادختساب يرصح

 
 

ةحصلا نم ققحتلا

.حيحص لكشب لمعي كيدل نيوكتلا نأ نم دكأتلل مسقلا اذه مادختسإ كنكمي

 لالخ نم مدختسملل يصخشلا رتويبمكلا زاهج نم SSL لاصتا ءاشنإل FQDN/IP مدختسأ ،لوألا لاصتالل ةبسنلاب .1

AnyConnect. 

 ليمعلا فيرعت فلم ClientProfile.xmlدوجو نم دكأت ،ةقباسلا ةوطخلا ذيفنت ةيناكمإ مدعو SSL لوكوتورب ليطعت ةلاح يف .2



 . C:\ProgramData\Cisco\Cisco Anyconnect Secure Mobility Client\Profile راسملا نمض يصخشلا رتويبمكلا ىلع

 .اهبلط درجمب ةقداصملل رورملا ةملكو مدختسملا مسا لخدأ .3

 .مدختسملا رتويبمك زاهج ىلع ليمعلا فيرعت فلم ليزنت متي ،ةحجانلا ةقداصملا دعب .4

 .AnyConnect ب لاصتالا عطق .5

 ليمعلا فيرعت فلم يف روكذملا فيضملا مسا رايتخال ةلدسنملا ةمئاقلا مدختسأ ،فيرعتلا فلم ليزنت درجمب .6

RAVPN-IKEV2  ب لاصتالل AnyConnect مادختساب IKEv2/IPsec. 

 .Connect رقنا .7

AnyConnect ةلدسنملا ةمئاقلا

.ISE مداخ ىلع اهؤاشنإ مت يتلا ةقداصملل رورملا ةملكو مدختسملا مسا لخدأ .8



AnyConnect لاصتا

.لاصتالا درجمب مدختسملا (IKEv2/IPsec) لوكوتوربلاو فيرعتلا فلم نم ققحتلا .9



AnyConnect لصتم

 :FTD يف رماوألا رطس ةهجاو تاجرخم

 

 

        <#root> 

 

firepower# show vpn-sessiondb detail anyconnect 

 

Session Type: AnyConnect 

 

Username : ikev2-user                    Index        : 9 

Assigned IP  : 10.1.1.1                  Public IP    : 10.106.55.22 

Protocol     : IKEv2 IPsecOverNatT AnyConnect-Parent 

License      : AnyConnect Premium 

Encryption   : IKEv2: (1)AES256 IPsecOverNatT: (1)AES-GCM-256 AnyConnect-Parent: (1)none 



Hashing      : IKEv2: (1)SHA512 IPsecOverNatT: (1)none AnyConnect-Parent: (1)none 

Bytes Tx     : 450                         Bytes Rx     : 656 

Pkts Tx      : 6                           Pkts Rx      : 8 

Pkts Tx Drop : 0                           Pkts Rx Drop : 0 

Group Policy : RAVPN-group-policy          Tunnel Group : RAVPN-IKEV2 

Login Time   : 07:14:08 UTC Thu Jan 4 2024 

Duration     : 0h:00m:08s 

Inactivity   : 0h:00m:00s 

VLAN Mapping : N/A                          VLAN         : none 

Audt Sess ID : 0ac5e205000090006596618c 

Security Grp : none                         Tunnel Zone  : 0 

 

IKEv2 Tunnels: 1 

IPsecOverNatT Tunnels: 1 

AnyConnect-Parent Tunnels: 1 

 

AnyConnect-Parent: 

Tunnel ID    : 9.1 

Public IP    : 10.106.55.22 

Encryption.  : none.                           Hashing     : none  

 

Auth Mode    : userPassword  

Idle Time out: 30 Minutes                      Idle TO Left : 29 Minutes  

Client OS    : win  

Client OS Ver: 10.0.15063  

Client Type  : AnyConnect  

Client Ver   : 4.10.07073  

 

IKEv2: 

Tunnel ID : 9.2 

UDP Src Port : 65220                            UDP Dst Port : 4500 

Rem Auth Mode: userPassword 

Loc Auth Mode: rsaCertificate 

Encryption   : AES256                            Hashing      : SHA512 

Rekey Int (T): 86400 Seconds                     Rekey Left(T): 86391 Seconds 

PRF : SHA512                                     D/H Group    : 19 

Filter Name  :  

Client OS    : Windows Client                    Type         : AnyConnect  

 

IPsecOverNatT: 

Tunnel ID    : 9.3 

Local Addr   : 0.0.0.0/0.0.0.0/0/0 

Remote Addr  : 10.1.1.1/255.255.255.255/0/0 

Encryption   : AES-GCM-256                       Hashing       : none  

Encapsulation: Tunnel  

Rekey Int (T): 28800 Seconds                     Rekey Left(T) : 28791 Seconds  

Idle Time Out: 30 Minutes                        Idle TO Left  : 29 Minutes  

Bytes Tx     : 450 Bytes                         Rx            : 656  

Pkts Tx      : 6                                 Pkts Rx       : 8  

 

 

 

 

firepower# show crypto ikev2 sa

 

  



 

IKEv2 SAs: 

 

Session-id:6, Status:UP-ACTIVE, IKE count:1, CHILD count:1 

 

Tunnel-id Local                         Remote                                           fvrf/ivrf            Status     Role 

16530741  10.197.167.5/4500             10.106.55.22/65220                                                    READY      RESPONDER 

Encr: AES-CBC, keysize: 256, Hash: SHA512, DH Grp:19, Auth sign: RSA, Auth verify: EAP 

Life/Active Time: 86400/17 sec 

Child sa: local selector 0.0.0.0/0 - 255.255.255.255/65535 

remote selector 10.1.1.1/0 - 10.1.1.1/65535 

ESP spi in/out: 0x6f7efd61/0xded2cbc8  

 

 

 

firepower# show crypto ipsec sa

 

  

 

interface: Outside 

    Crypto map tag: CSM_Outside_map_dynamic, seq num: 30000, local addr: 10.197.167.5 

     

      Protected vrf:  

      local ident (addr/mask/prot/port): (0.0.0.0/0.0.0.0/0/0) 

      remote ident (addr/mask/prot/port): (10.1.1.1/255.255.255.255/0/0) 

      current_peer: 10.106.55.22, username: ikev2-user 

      dynamic allocated peer ip: 10.1.1.1 

      dynamic allocated peer ip(ipv6): 0.0.0.0 

      

      #pkts encaps: 6, #pkts encrypt: 6, #pkts digest: 6 

      #pkts decaps: 8, #pkts decrypt: 8, #pkts verify: 8 

      #pkts compressed: 0, #pkts decompressed: 0 

      #pkts not compressed: 0, #pkts comp failed: 0, #pkts decomp failed: 0 

      #pre-frag successes: 0, #pre-frag failures: 0, #fragments created: 0 

      #PMTUs sent: 0, #PMTUs rcvd: 0, #decapsulated frgs needing reassembly: 0 

      #TFC rcvd: 0, #TFC sent: 0 

      #Valid ICMP Errors rcvd: 0, #Invalid ICMP Errors rcvd: 0 

      #send errors: 0, #recv errors: 0 

 

      local crypto endpt.: 10.197.167.5/4500, remote crypto endpt.: 10.106.55.22/65220 

      path mtu 1468, ipsec overhead 62(44), media mtu 1500 

      PMTU time remaining (sec): 0, DF policy: copy-df 

      ICMP error validation: disabled, TFC packets: disabled 

      current outbound spi: DED2CBC8 

      current inbound spi : 6F7EFD61 

 

  inbound esp sas: 

     spi: 0x6F7EFD61 (1870593377) 

     SA State: active 

     transform: esp-aes-gcm-256 esp-null-hmac no compression  

     in use settings ={RA, Tunnel, NAT-T-Encaps, IKEv2, } 

     slot: 0, conn_id: 9, crypto-map: CSM_Outside_map_dynamic 

     sa timing: remaining key lifetime (sec): 28723 

     IV size: 8 bytes 

     replay detection support: Y 

     Anti replay bitmap:  



     0x00000000 0x000001FF 

 

  outbound esp sas: 

    spi: 0xDED2CBC8 (3738356680) 

    SA State: active 

    transform: esp-aes-gcm-256 esp-null-hmac no compression  

    in use settings ={RA, Tunnel, NAT-T-Encaps, IKEv2, } 

    slot: 0, conn_id: 9, crypto-map: CSM_Outside_map_dynamic 

    sa timing: remaining key lifetime (sec): 28723 

    IV size: 8 bytes 

    replay detection support: Y 

    Anti replay bitmap:  

    0x00000000 0x00000001 

 

 

  

:ISE تالجس

ISE - ةرشابملا تالجسلا

اهحالصإو ءاطخألا فاشكتسا
.اهحالصإو نيوكتلا ءاطخأ فاشكتسال اهمادختسإ كنكمي تامولعم مسقلا اذه رفوي

 

debug radius all 
debug crypto ikev2 platform 255 
debug crypto ikev2 protocol 255 
debug crypto ipsec 255  

 



ةمجرتلا هذه لوح
ةيلآلا تاينقتلا نم ةعومجم مادختساب دنتسملا اذه Cisco تمجرت
ملاعلا ءاحنأ عيمج يف نيمدختسملل معد ىوتحم ميدقتل ةيرشبلاو
امك ةقيقد نوكت نل ةيلآ ةمجرت لضفأ نأ ةظحالم ىجرُي .ةصاخلا مهتغلب
Cisco يلخت .فرتحم مجرتم اهمدقي يتلا  ةيفارتحالا ةمجرتلا عم لاحلا وه
Systems ىلإ اًمئاد عوجرلاب يصوُتو تامجرتلا هذه ةقد نع اهتيلوئسم
.(رفوتم طبارلا) يلصألا يزيلجنإلا دنتسملا


